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Inledning 

Grattis till att du valt det nya programmet Noxturnal®. Noxturnal är ett modernt 

sömndiagnosprogram som har utformats särskilt med tanke på användarvänlighet och effektivitet. 

Programmets huvudfunktion är att bearbeta inspelningar från Nox Medical-registreringsenheter (se 

kapitlet Registreringsenheter som kan användas). Med hjälp av programmet kan användaren 

konfigurera inspelningar, ladda ned data samt hantera analysering och rapportering. 

Avsedd användning 

Programmet Noxturnal är avsett för att konfigurera Nox-registreringsenheter inför sömnstudier samt 

för nedladdning och arkivering av tidigare studier från enheterna. 

Programmet Noxturnal är avsett för granskning och analys av fysiologiska signaler samt för 

presentation av analysresultaten i form av rapporter. 

De miljöer där programmet är avsett att användas omfattar sjukhus, vårdinrättningar, sömncenter, 

sömnkliniker och andra testmiljöer. 

Kontraindikationer 

Programmet Noxturnal är INTE avsett för patientövervakning eller automatisk diagnos. 

Omfattning 

Den här användarhandboken omfattar programmet Noxturnal. Den omfattar inte Nox-

registreringsenheterna och de tillbehör som krävs för inspelning av fysiologiska signaler. 

Varningar och försiktighetsåtgärder  

 Nox-registreringssystemen är INTE GODKÄNDA FÖR KONTINUERLIG ÖVERVAKNING där 

patientskador eller dödsfall kan orsakas om systemen slutar att fungera. Termen 

KONTINUERLIG ÖVERVAKNING (CONTINUOUS MONITORING) specificeras i standarden 

IEC 60601-1. 

 Nox-registreringssystemen är endast avsedda att vara en hjälp vid patientbedömning. Det 

måste användas tillsammans med andra metoder vid bedömning av kliniska tecken och 

symptom. 

 Varning: Enligt amerikansk (federal) lag får denna enhet endast säljas eller ordineras av läkare. 

 Nox-reistreringsenheter och deras tillbehör ska avlägsnas från patienten innan data laddas ned. 

 Nox-registreringsenheten får under inga omständigheter anslutas till USB-porten medan 

patienten använder den. Det kan leda till allvarliga patientskador. 

 

 Läs noggrant den här användarhandboken före användning, i synnerhet de 

avsnitt som är markerade med ett utropstecken. 
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Beskrivning av programmet 

Programmet Noxturnal interagerar med Nox-registreringsenheter. Med hjälp av programmet kan 

användaren konfigurera enheten samt hantera navigering, analysering, rapportering och arkivering av 

inspelningar från enheten. I det här avsnittet beskrivs programmets huvudfunktioner och hur 

programmet installeras. 

Kompatibla registreringsenheter  

Noxturnal har stöd för följande registreringsenheter och deras tillbehör: 

 Nox A1 PSG-registreringsenhet 

 Nox T3-sömnregistreringsenhet 

Installera Noxturnal  

Innan du installerar programmet Noxturnal ska du ta reda på vilka systemkrav som gäller för att 

använda det. 

Systemkrav för Noxturnal 

I tabellerna nedan visas minsta maskinvarukrav och de maskinvarukrav som rekommenderas för 

effektiv installation och användning av programmet. 

 

 Datorn måste uppfylla kraven i den internationella standarden IEC 60950-1 för 

säkerhet avseende utrustning för informationsbehandling. 

Minimisystemkrav för stationär dator 

Maskinvarutyp Rekommenderas 

Operativsystem Windows® XP Home eller Professional med Service Pack 2 

Processor Intel X86-baserad eller AMD 

Processorns klockhastighet Minst 1,7 GHz 

Minne Minst 512 MB 

Ledigt hårddiskutrymme Minst 500 MB 

Grafikupplösning Minst 1024 x 768 

USB-port Ja 

Minimisystemkrav för bärbar dator 

Maskinvarutyp Rekommenderas 

Operativsystem Windows® XP Home eller Professional med Service Pack 

2 

Processor Intel X86-baserad eller AMD 

Processorns 

klockhastighet 

Minst 1,2 GHz 

Minne Minst 512 MB 
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Ledigt 

hårddiskutrymme 

Minst 500 MB 

Grafikupplösning Minst 1024 x 768 

USB-port Ja 
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Systemkrav som rekommenderas för stationär dator  

Maskinvarutyp Rekommenderas 

Operativsystem Windows 8.1 

Processor Intel X86-baserad eller AMD 

Processorns klockhastighet Minst 2,0 GHz 

Minne Minst 2 GB 

Ledigt hårddiskutrymme Minst 2 GB 

Grafikupplösning Minst 1600 x 1200 

USB-port Ja 

Systemkrav som rekommenderas för bärbar dator 

Maskinvarutyp Rekommenderas 

Operativsystem Windows 8.1 

Processor Intel X86-baserad eller AMD 

Processorns klockhastighet Minst 1,5 GHz 

Minne Minst 2 GB 

Ledigt hårddiskutrymme Minst 500 MB 

Grafikupplösning Minst 1600 x 1200 

USB-port Ja 

Installationsanvisningar 

 Säkerställ att du är inloggad i systemet som administratör. 

 Bläddra till filen Setup.exe på installations-cd:n och kör den. 

 Nu öppnas en guide med stegvisa instruktioner för installationen. Installera programmet 

genom att följa instruktionerna. 
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Köra Noxturnal 

Kör programmet Noxturnal genom att dubbelklicka på skrivbordsikonen eller på programikonen på 

startmenyn i Windows. Stäng programmet genom att klicka på X i det övre högra hörnet eller genom 

att välja Exit på menyn File. 

När Noxturnal startas visas arbetsytan, se bilden nedan. Om en enhet är ansluten visas den i bilden. 

Enheter som inte är anslutna visas inte i bilden. I demonstrationssyfte visas en ansluten Nox A1-

registreringsenhet i bilden nedan. 

 

 

Start Page är den sida där användaren hanterar Nox-enheterna och inspelade data. På den här sidan 

får användaren också hjälp att utföra de vanligaste funktionerna i programmet: 

 View Existing Recording: Med det här alternativet öppnas inspelningsbiblioteket. I 

inspelningsbiblioteket finns en lista med alla inspelningar som antingen har laddats ned eller 

lagts till manuellt i inspelningsbiblioteket. Mer information finns i avsnittet 

Inspelningsbiblioteket. 

 Start a New Recording: Välj det här alternativet om du vill starta en ny inspelning. En 

konfigurationsguide visas med stegvisa instruktioner för konfigurationsprocessen. Mer 

information finns i avsnittet Starta en ny inspelning. 

 Download and View Recording: Om en registreringsenhet är ansluten och den innehåller en 

inspelning, kan du ladda ned och granska inspelningen. Mer information finns i avsnittet 

Ladda ned en inspelning från en Nox-registreringsenhet.  
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Ansluta en Nox-registreringsenhet til l Noxturnal  

Noxturnal används för att konfigurera och ladda ned inspelade data från en Nox-registreringsenhet. 

Börja med att ansluta registreringsenheten till datorn med hjälp av en USB-kabel. Enheten letas 

automatiskt upp av Noxturnal och information om enheten visas längst upp till höger på sidan Start 

Page. Det kan ta 2–4 sekunder innan programmet hittar enheten. Om enheten inte hittas klickar du 

på länken Scan for Devices. 

 

När den anslutna enheten hittas av Noxturnal visas följande information om enheten: 

inspelningsstatus, det fasta programmets version och enhetens namn. I bildexemplet visas en Nox 

A1-registreringsenhet, men vilken Nox-registreringsenhet som helst kan visas i fönstret, förutsatt att 

programmet har stöd för enheten. 

 

 

Vilken åtgärd du utför på registreringsenheten beror på enhetens status, som kan vara följande: 

 Empty – Enheten har inte konfigurerats och innehåller inte några inspelningar. Klicka på Start 

a New Recording om du vill konfigurera enheten för en ny inspelning. Observera att 

eventuella befintliga inspelningar tas bort från enheten när den konfigureras. 

 Ready to Record – Enheten har konfigurerats men innehåller inte några inspelningar. Nu kan 

du koppla från enheten och starta inspelningsprocessen. 

 Ready to Download – Enheten innehåller en inspelning som inte har laddats ned till datorn. 

Klicka på knappen Download and View Recording om du vill ladda ned inspelningen till 

datorn. 

 Download Complete – Enheten innehåller en inspelning som redan har laddats ned och lagts 

till i inspelningsbiblioteket. Nu kan du antingen konfigurera enheten för en till inspelning 
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genom att klicka på Start a New Recording eller ladda ned inspelningen igen genom att klicka 

på Download and View Recording. 

När du är klar med enheten klickar du på länken Eject Device och tar loss enheten från datorn. 

 

 Observera att det är möjligt att koppla ur enheten från datorn utan att först 

välja Eject Device, även om det inte rekommenderas. 

 Om en enhet är ansluten men inte visas på startsidan klickar du på länken Scan 

for Devices. Om det inte fungerar finns mer information i avsnittet Felsökning. 

Uppgradera registreringsenhetens programvara 

Om en ny programvaruversion finns tillgänglig för den anslutna enheten visas en inforuta i Noxturnal 

bredvid enheten. Funktionen är enhetsoberoende, och typen av enhet visas i fönstret beroende på 

vilken enhet som är ansluten. I bildexemplet är en Nox T3-registreringsenhet ansluten. 

 

Du kan antingen välja att ignorera meddelandet och fortsätta eller, vilket alltid rekommenderas, 

uppgradera enhetens programvara. Uppgradera genom att klicka på inforutan och sedan följa de 

anvisningar som visas. 

 

 När du har klickat på inforutan måste du koppla ur registreringsenheten från 

datorn och ansluta den igen för att uppgraderingen av det fasta programmet ska 

börja gälla. 
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Starta en ny inspelning 

Förbered registreringsenheten för en ny inspelning genom att starta programmet Noxturnal och 

ansluta enheten till datorn med en USB-kabel. Enheten letas automatiskt upp av Noxturnal och 

information om den visas på sidan Start Page. Klicka på knappen Start a New Recording på sidan Start 

Page så öppnas en guide som innehåller stegvisa instruktioner för konfigurering av enheten. 

Konfigurationsguiden är enhetsberoende. Det betyder att varje registreringsenhet som kan användas 

har sin egen konfigurationsguide. Guiderna varierar något när det gäller grafik och vilka alternativ som 

är tillgängliga. De grundläggande stegen är dock desamma i alla guider: 

1.) Enhetens konfiguration. I det här steget väljer du inspelningsmallar, 

registreringskanaler, studietyper och andra enheter som kan anslutas. 

2.) Schemaläggning av inspelningen, där du kan välja vilken dag och vilket 

klockslag inspelningen ska starta eller att patienten startar inspelningen själv. 

3.) Patientinformation, där du anger nödvändig patientinformation inför 

inspelningen. 

I den här användarhandboken visas konfigurationsguiden för Nox A1-registreringsenheten. 

På den första sidan i guiden anger du vilken inspelningsmall som ska användas vid inspelningen. 

  

Inspelningsmallarna har beskrivande namn som avslöjar vilken inspelningstyp de ska användas för. Du 

kan registrera inspelningsmallarna med hjälp av länken edit…. 

I avsnittet Inspelningsmallar finns mer information om hur du skapar och redigerar inspelningsmallar. 

Om din inspelningsmall har konfigurerats till att registrera data från en Bluetooth®-enhet, t.ex. en 

pulsoximeter, visas det i konfigurationsguiden. Du måste para ihop Bluetooth-enheten med 

registreringsenheten för att kunna använda den. Mer information finns i avsnittet Inspelningsmallar. 

Ange oximeterns BDA-nummer i rätt fält.  

Klicka på knappen Next för att gå till nästa sida, där du kan schemalägga registreringsenhetens 

inspelningstider. 
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 Om du markerar alternativet Manually Start Recording ansvarar användaren för att 

starta/stoppa inspelningen från registreringsenheten. Inspelningen startas i så fall genom att 

användaren trycker på och håller ned mittknappen på enheten tills det står på enhetens 

display att inspelningen har startat. 

 Markera alternativet Start Recording At: om du vill ange en specifik inspelningstid. Enheten 

slås på automatiskt och inspelningen startar den tid som angetts. Om användaren väljer att 

spela in under mer än en natt startar varje inspelning samma tid varje natt. 

 Om du vill att enheten ska stoppa inspelningen efter en bestämd tidsperiod kan du under 

Duration välja följande alternativ: 7 Hours, 8 Hours, 10 Hours eller ange en valfri tidsperiod. 

Om du väljer alternativet Unspecified ansvarar användaren för att stoppa inspelningen. 

Inspelningen stoppas i så fall genom att användaren trycker på och håller ned mittknappen 

på enheten tills det står på enhetens display att inspelningen har stoppats. 

 

Klicka på knappen Next för att gå vidare till sidan med patientinformation där du kan ange detaljerad 

information om patienten. Patientnamn eller patient-id är det enda fält som är obligatoriskt.  
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Du kan också lägga till filer eller dokument i patientinformationen och till och med redigera 

informationen med hjälp av motsvarande knappar. 

När du har angett önskad information klickar du på knappen Finish. Nu skrivs konfigurationen till 

enheten. 

När du har tryckt på knappen Finish är enheten konfigurerad. Om det finns inspelningar på enheten 

visas en dialogruta där du får frågan om inspelningarna ska raderas. 

Slutligen visas en bekräftelsesida som bekräftar att enheten har konfigurerats. För vissa 

registreringsenheter (t.ex. Nox T3) kan du skriva ut installationsanvisningarna genom att välja Print 

Hookup Instructions. En PDF-fil med installationsanvisningarna öppnas och kan skrivas ut. Om det 

inte finns några installationsanvisningar visas inte alternativet. 
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När du är klar med enheten markerar du alternativet Disconnect Device. Nu kopplas enheten på ett 

säkert sätt bort från datorn. Ta ut USB-kabeln och börja använda enheten. 
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Ladda ned en inspelning från en Nox-registreringsenhet 

Ladda ned inspelade data från en registreringsenhet till datorn genom att först säkerställa att 

Noxturnal körs och sedan ansluta enheten till en USB-port på datorn. 

Enheten letas automatiskt upp av Noxturnal och information om den visas på sidan Start Page. Det 

kan ta 2–4 sekunder innan programmet hittar enheten. Om enheten inte hittas klickar du på länken 

Scan for Devices. 

Klicka på knappen Download and View Recording på sidan Start Page så börjar Noxturnal ladda ned 

inspelningen från enheten till datorn. En dialogruta öppnas där stegen i nedladdningen visas. Först 

laddas data ned, därefter körs standardanalysprotokollet och sist startar ljudnedladdningen, om 

enheten har konfigurerats för att spela in ljud. Du kan när som helst välja att börja arbeta med data 

medan de laddas ned genom att klicka på länken Start Working. 

 

När nedladdningen har slutförts får du ett meddelande och kan börja arbeta med hela inspelningen. 

Inspelningar laddas alltid ned till standardplatsen för datalagring. Du kan ändra standardplatsen för 

datalagring på fliken Automation i dialogrutan för verktygsalternativ (Tools → Settings… → 

Automation). Nedladdade inspelningar läggs automatiskt till i inspelningsbiblioteket och du kan när 

som helst granska dem genom att gå till inspelningsbiblioteket och öppna det. Mer information finns i 

avsnittet Inspelningsbiblioteket.  

 

 Om en nedladdning av någon anledning delvis misslyckas, kan det leda till 

ofullständiga inspelningsresultat. Om detta inträffar får du en varning och måste 

fastställa om inspelade data är kompletta eller inte. Det går att ladda ned 

samma data från enheten igen. Läs avsnittet Felsökning om problemet 

kvarstår. 

 Den nedladdade inspelningen raderas inte från enheten förrän enheten 

konfigureras för en annan inspelning. 

 

Inspelningsresultatsidan 

Efter nedladdning från en registreringsenhet eller efter att ha öppnat en befintlig inspelning i 

Noxturnal, visas sidan Recording Results. Den här sidan innehåller en översikt över de vanligaste 

analysparametrarna och de inspelade signalerna. Resultatsidan uppdateras automatiskt när ändringar 

görs i befintlig scoring eller om en automatisk analys körs. När sömnstadier är tillgängliga (gäller t.ex. 
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inspelningar från Nox A1-enheten) visas motsvarande diagram och information. För Nox T3-enheten 

visas endast de parametrar som är tillgängliga för den enheten. 

 

 

Kommandon på resultatsidan 

På resultatsidan finns knappar för följande åtgärder: 

 Close Recording: Med det här alternativet stängs den aktiva inspelningen och startsidan 

öppnas. 

 Recording Status: Med det här alternativet kan du ange status för inspelningar. Nedladdade 

inspelningar har alltid status New. Om en inspelning av någon anledning har misslyckats kan 

status anges till Invalid. Om inspelningen har diagnosticerats kan status anges till Scored. Om 

aktuell inspelning och scoring har granskats kan status anges till Reviewed. Om en inspelning 

har diagnosticerats och godkänts kan status anges till Done. 

 Play Audio: Om inspelningen innehåller ljud kan du spela upp ljudet med knappen Play 

Audio. Du kan också spela upp eller pausa uppspelningen genom att trycka på 

mellanslagstangenten. 

 View Signals: Med det här alternativet väljs den första tillgängliga signalsidan, där du kan 

bläddra mellan de inspelade signalerna, visa händelser som markerats automatiskt och 

redigera markerade händelser manuellt. 

 Print Results Page: Med det här alternativet kan du skriva ut inspelningsresultatsidan. 

Patientinformation 

I fönstret Information visas information om den inspelade patienten. Redigera 
inspelningsinställningarna och patientinformationen genom att välja länken Edit eller kortkommandot 
Ctrl+I. 
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Redigera olika typer av inspelningsegenskaper genom att välja File → Recording Properties… på 
programmets huvudmeny. 
 

Sömnparametrar 

I fönstret Sleep Parameters visas huvudanalysparametrarna och deras relation till svårighetsgrad. AHI 

(Apnea Hypopnea Index) är antalet apnéer och hypopnéer per sömntimme, och ODI är antalet 

scorade syredesaturationer per sömntimme (vid automatisk standardanalys scoras alla desaturationer 

till 3 % eller mer, men det kan anpassas av användaren). De svårighetsgrader som anges är Normal → 

Mild → Moderate → Severe och dessa överensstämmer med de nivåer som fastställts av AASM 

(American Academy of Sleep Medicine). Om mer än en natt har spelats in visar de här parametrarna 

medelvärdena för alla nätter. Mer information finns i avsnittet Analysprotokoll. 
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Signalöversikt och parametrar 

Fönstret Signal Overview är ett verktyg för helhetsgranskning med vars hjälp du effektivt kan granska 

och redigera inspelningsresultat. Fönstret är indelat i två delar med analysparametrar till höger och en 

signalöversikt till vänster. 

 

I analysparameterområdet visas en sammanfattning av de vanligaste analysparametrarna, t.ex. 

Hypnogram, Total Sleep Time, AHI etc., för en enskild natt. Om mer än en natt har spelats in visas 

varje natt i ett eget fönster. Varje parameter är färgkodad från grönt till rött efter sin svårighetsgrad 

(Normal → Mild → Moderate → Severe). 

 Arousal Index är antalet uppvaknanden per timme under sömnen. 

 Sleep Onset Latency är antal minuter från det att ljuset släcks (analysens starttid) till den 

första perioden scorad sömn. 

 REM Onset Latency är antalet minuter från det att sömnen infaller till den första REM-

sömnperioden. 

 Sleep efficiency varierar mellan 0 och 100 % där 0 % innebär att patienten har varit vaken 

hela natten och 100 % att patienten sovit hela natten. När sömnscoring-funktionen inte är 

tillgänglig uppskattar programmet istället parametern med hjälp av rörelseperioder. 

 Total Sleep Time är den tid då patienten sov. 

 När alternativet Total Sleep Time inte är tillgängligt, används parametern Est. Total Sleep 

Time. Det är den tid då patienten ligger ned under inspelningen. Grön färgkod (normal) visas 

när patienten ligger ned i mer än 6 timmar. 

 Andning visas med index. Index är en metod för att visa analysparametrar på ett 

standardiserat sätt. 

o AHI (Apnea Hypnoea Index) 

o AI (Apnea Index) 

o HI (Hypopnea Index) 

o ODI (Oxygen Desaturation Index) visar antal desaturationer i syremättnaden per 

timme av den tid då patienten sover, Total Sleep Time, eller alternativt ligger i 

sängen, Est. Total Sleep Time. 
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o Snore Percentage är den andel av sömntiden då snarkningsepisoder förekommer 

(markeras som Snore Trains). 

 Övergripande Signal Quality fastställs efter att signalkvaliteten hos följande signaler har 

övervakats: oximeter, luftflöde och andningsrörelser från buk eller bröstkorg. Den lägsta 

signalkvaliteten hos dessa signaler visas som övergripande Signal Quality på 

inspelningsresultatsidan och kan ha ett värde mellan 0 och 100 %. 

Signaler och händelser 

De signaler och händelser som är plottade i signalöversiktsfönstret ger en översikt över en hel natt. 

 Signalerna i översikten kan omfatta följande: 

o Spektrogram för den kanal som visas på skärmen 

o Uppvaknanden/hypnogram visar uppvaknanden och sömnstadier under natten 

o Sömntid 

o Rörelse 

o Läge 

o Apnéer/RIP-fas (fas mellan andningsrörelsesignaler från buk och bröstkorg) 

o Syremättnad (SpO2) 

o Puls 

o Ljudvolym (snarkning i dB)  

o Benrörelser (tillval) 

 Händelser som visas i översikten omfattar apné och hypopné, syredesaturationer, 

snarkningsepisoder och artefakter. 

När musen flyttas över ikonerna Arousals/Hypnogram, Sleep time/Movement/Position, 

Apneas/RIP Phase och O2 Desaturation samt Pulse visas mer information om motsvarande signal 

eller händelse. 

Ändra analysperioder 

Om en inspelning startar innan alla sensorer har sätts fast på eller om patienten tar bort sensorerna 

innan inspelningen slutar, går det att justera det intervall som ska analyseras genom att flytta 

markörerna för analysens start  och stopp  till önskad plats inom inspelningen. Alla 

analysparametrar uppdateras enligt justeringarna. 
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Använd synkroniseringsmarkören  för att navigera i inspelningen. Alla signalsidor, t.ex. Respiration 

och Pulse Oximeter synkroniseras i enlighet därmed. Om du upptäcker en intressant händelse i 

översikten drar du synkroniseringsmarkören till det området och trycker på knappen View Signals så 

visas råsignalerna. Om du vill utesluta ogiltiga data från inspelningsområdena på signalsidorna, 

markerar du områdena och infogar händelsen ”Invalid Data”. Om du vill utesluta data där patienten är 

vaken infogar du händelsen ”Awake”. Alla ”Awake”- och ”Invalid Data”-händelser utesluts från 

rapportberäkningarna. 

Ställa in enhet 

Om du vill ändra enhet väljer du Tools → Settings… på programmets huvudmeny. På egenskapssidan 
General letar du reda på rullistan System Units och väljer det fält du vill redigera. 
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Visa signaler 

Menyknappen för arbetsytan 

Med menyknappen för arbetsytan kan du lägga till en eller flera sidor i en sidlayout. Knappen sitter 

längst uppe till vänster i Noxturnal.  

 

Du kan använda knappen för att lägga till sidor utifrån dina signalsidlayouter, datasidor eller 

rapporter. Det är ett utmärkt sätt att hantera hur du vill visa dina inspelningar, inklusive sidor och 

rapporter.  

 

Med knappen för arbetsytans layout kan du spara alla ändringar du gör på arbetsytan för framtida 

användning. Det betyder att du kan ändra inställningar för kurvorna, öppna de rapporter du vanligtvis 

använder och konfigurera arbetsmiljön på ett sätt som passar dig. Via knappen kan du spara aktuell 

layout, skapa en ny layout, använda en standardlayout att basera den på eller till och med återställa 

layouter efter att du gjort ändringar. Det är ett bra sätt att skapa olika vyer av samma data, utifrån 

användarens behov. 

Signalsida 

En signalsida är en flik på arbetsytan där en eller flera signaler visas. Noxturnal levereras med 

fördefinierade signalsidor, t.ex. sidan Respiratory, sidan PSG och sidan Pulse Oximeter. 

Lägg till eller ta bort signaler på en signalsida genom att flytta musen till aktivitetsfönstret Signals and 

Data till höger på arbetsytan. När muspekaren står på den här fliken, öppnas aktivitetsfönstret Signals 

and Data. En lista över alla tillgängliga signaler visas i det här aktivitetsfönstret. En kryssruta bredvid 
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signalen indikerar om signalen visas på sidan eller inte. Markera/avmarkera kryssrutan för att lägga till 

eller ta bort signalen från sidan. 

Hantera signaler 

 

Med hjälp av navigeringsfältet kan du snabbt navigera till valfri tidpunkt i inspelningen. Det blå 

strecket visar var du befinner dig i inspelningen. Klicka var som helst i fältet för att gå till den 

tidpunkten. Observera att en måne indikerar när det är natt och en sol när det är dag. 

På tidsaxeln visas inspelningstiden och tidsperioden för det aktuella fönstret. Högerklicka på 

tidsaxeln om du vill ändra intervallet i fönstret. Dra ut/komprimera tidsaxeln med musen om du 

vill ändra tidsintervallet i fönstret. 

Synkroniseringsmarkören som sitter på tidsaxeln används för synkronisering med andra 

signalsidor och vyer. Klockan till höger i navigeringsfältet visar tidpunkten för markörens 

position. Synkroniseringsmarkören kan dras och flyttas i tid. 

Signalvärdeaxeln visar namnet på den aktuella plottade signalen och värdeaxelns skala. Axlarna 

kan dras ut/komprimeras med musen. Om du vill ändra värdeaxelns egenskaper dubbelklickar du 

på axeln. Då visas en dialogruta där du kan ändra egenskaperna. 

Plottad signal i ett fönster. Signaler kan justeras på många sätt. Ändra storlek på signalfönstret 

eller flytta omkring signalfönstret med musen. Om du vill ändra signalens egenskaper 

dubbelklickar du på signalen. Då visas en dialogruta där du kan ändra signalegenskaperna. 

Navigera med tangentbordet 

Du kan också navigera i och ändra signalsidan genom att använda följande kortkommandon: 
 
Navigering: 

 Högerpil = halva sidan hoppar framåt 

 Vänsterpil = halva sidan hoppar bakåt 

 Page down = sidan hoppar framåt 

 Page up = sidan hoppar bakåt 

 Home = inspelningsstart 

 End = inspelningsslut 

 Skift + högerpil = öka tidsspannet i fönstret 

 Skift + vänsterpil = minska tidsspannet i fönstret 

 Skift + ctrl + vänsterpil = gå till föregående datasession 

 Skift + ctrl + högerpil = gå till nästa datasession 
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 – = zooma ut från valt område 

 + = zooma in i valt område 

 Mushjul = bläddra framåt/bakåt 

 Mushjul + ctrl = bläddra uppåt och nedåt 

Aktiv signal: 

 Skift + uppåtpil = öka signalskalning 

 Skift + nedåtpil = minska signalskalning 

 Ctrl + uppåtpil = flytta signalen uppåt 

 Ctrl + nedåtpil = flytta signalen nedåt 

 Skift + returtangenten = visa aktiv signal på ny sida 

 Skift + delete = ta bort aktiv signal från sidan 

 Uppåtpil = välj signal ovanför 

 Nedåtpil = välj signal nedanför 

 Ctrl + f = hitta händelser 

 F9 = automatisk skalning av signal 

Signalsida: 

 Mellanslag = spela upp/pausa uppspelning av inspelning 

 Ctrl + w = automatisk skalning av signaler 

 Ctrl + a = ordna signaler 

Händelser: 

 Tabb = nästa händelse, om sökning: nästa sökresultat 

 Skift + tabb = föregående händelse, om sökning: föregående sökresultat 

 Delete = radera valda händelser eller radera händelser som överlappar val 

 Returtangenten = avmarkera alla händelser 

 Esc = rensa alla val 

 

Hantera händelser 

Händelser används för att identifiera intressanta områden i en signal. Händelser har en start- och en 

stopptid och klassificeras i olika typer. Händelser kan läggas till manuellt i en signal eller scoras i den 

automatiska analysen för att markera intressanta områden. Händelser kan ändras och tas bort. 

Scora en händelse 

För att scora en händelse ska du gå till en sida som innehåller signaler och sedan leta reda på ett 

intressant signalområde. 

 Markera det område där du vill scora en händelse med vänster musknapp. 

 Välj kortkommandot för den aktuella händelsen. En lista med kortkommandon för scoring finns 

under Edit → Configuration → Scoring Shortcut Keys… 
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Du kan också scora en händelse genom att markera området med vänster musknapp, som ovan, men 

sedan högerklicka på området och välja en händelse i listan. 

Radera en händelse 

Det finns flera sätt att radera befintliga händelser: 

 Markera händelsen genom att vänsterklicka på den och tryck sedan på Delete. 

 Högerklicka på händelsen och välj Remove Event. 

 Markera ett område med musen som korsar de händelser du vill radera och tryck på Delete. 

Flytta en händelse 

Om du vill flytta en händelse till en annan plats markerar du händelsen genom att hålla ned vänster 

musknapp och sedan dra händelsen till önskad plats. Händelser kan både dras mellan signaler och till 

en annan tidsperiod. 

Ändra storlek på en händelse 

Om du vill ändra storlek på en händelse flyttar du muspekaren till händelsens vänstra eller högra 

gränslinje. Muspekarens ikon ändras till en pil som pekar till höger och vänster. När ikonen har 

ändrats till en pil vänsterklickar du på och drar händelsen till önskad tidslängd. 
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Navigera bland händelser 

Det finns flera sätt att navigera bland de scorade händelserna i inspelningen: 

 Du kan hoppa mellan de händelser som har scorats i en signal genom att klicka på signalen 

och trycka på tabb-tangenten för att gå till nästa händelse i tiden. Om du istället vill gå till 

föregående händelse i tiden trycker du på skift + tabb. 

 Längst upp till höger på arbetsytan finns en söktextruta där du kan söka bland alla händelser 

som har scorats. När du klickar på textrutan visas en rullista med alla händelsetyper som har 

scorats. Om du vill söka efter händelser av en viss typ klickar du på motsvarande händelsetyp 

i listan. Nu visas nästa händelse i tiden som tillhör den typen. Klicka på navigeringsknapparna 

i rullistan för att navigera bland händelserna. 

 Välj View –> Event Overview så öppnas ett översiktsfönster där alla händelser som har 

scorats i inspelningen visas i ett diagram. Om du vill gå till en specifik händelse klickar du på 

den i översiktsdiagrammet. 
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Datasida 

Med datasidor kan du visa händelser, signaler och scoringar och till och med skapa formler i 

tabellformat för smidig export och analys.  

Skapa en ny datasida med menyknappen för arbetsytan: välj Add Sheet och sedan Empty Event Grid 

eller Empty Signal Grid i rullistan. Vilket alternativ du väljer beror på om du är mest intresserad av 

händelserna eller de faktiska signalvärdena. 

En ny sida läggs till i layouten. Nu kan du börja lägga till de poster du är intresserad av på sidan med 

hjälp av knappen Add Column och länken Event Selection. Du kan dra de flesta händelsetyper och 

signaler till vyerna och sedan spara i tabellformat för ytterligare analys med knappen Export…. 

  

 

Analysprotokoll 

Ett analysprotokoll är en uppsättning detektorer som kan köras på inspelningen för att hitta och 
markera olika händelser inom de inspelade signalerna. De analysprotokoll som finns tillgängliga, 
inklusive standardprotokollen, finns på menyn Analysis. Om du vill köra ett analysprotokoll på 
inspelningen väljer du önskat protokoll på menyn Analysis och klickar på det. 

Skapa ett nytt analysprotokoll, där anpassade inställningar och/eller detektorer används, genom att 

välja Analysis → Manage Protocols på huvudmenyn.  

Du kan redigera och ändra namn på ett befintligt protokoll, eller skapa ett nytt som baseras på ett 

befintligt protokoll. 
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En ny sida öppnas där det nya/redigerade protokollet kan definieras. En ny analysprotokollsida 

öppnas där det nya protokollet kan definieras. Ett protokoll är en uppsättning detektorer vars 

funktion är att hitta intressanta områden inom en signal och scora händelser i dessa områden.   

Lägg till en detektor i protokollet genom att välja en detektor i listan med detektorer och välja Add 

Detector. Allmänna egenskaper och ingångssignal kan redigeras.   

 

Hantera scoringar 

En scoring är en uppsättning händelser som har scorats på signaler i inspelningen. Aktiviteterna för 

hantering av scoringar hittar du via knappen Scorings i verktygsfältet. Nedan visas vilka aktiviteter du 

kan välja när du hanterar scoringar. 

 

Standardanalysprotokollet används automatiskt i Noxturnal när en nedladdad inspelning från en 

registreringsenhet analyseras. På så sätt skapas en ny scoring som kallas Untitled Scoring. På 

scoringknappen (den röda rutan ovan) visas alltid den valda scoring som används för rapporterings- 

och inspelningsöversiktsfunktionerna. Du kan enkelt skapa nya scoringar med funktionerna under 

scoringknappen. Om du exempelvis gör ändringar i den automatiska scoringen kan du spara 

ändringarna som en ny scoring och kalla den ”manuell scoring”. 

Via scoringknappen kan du också lägga till perioder eller textmeddelanden i inspelningen. 
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Ny scoring 

När du använder enheter som spelar in EEG kan du använda sömnstadiefunktionerna i Noxturnal. I 

Noxturnal finns en automatisk sömnstadiefunktion, men det är också möjligt att hantera 

sömnstadierna manuellt.  

Den manuella hanteringen av sömnstadier går till så att du väljer New Scoring på scoringknappen. 

 

Därefter väljer du alternativet ”Start Sleep Staging” på menyn under scoringknappen. Det numeriska 

tangentbordet används som standardsnabbtangenter för sömnstadiefunktionen. Du kan ändra 

snabbtangenterna för scoring enligt anvisningarna nedan. 

Här kan du också välja alternativet Bio Calibration. 

Välja en scoring 

Flera scoringar kan tillhöra samma inspelning. Alla tillgängliga scoringar visas i fönstret med scoringar. 

Välj aktiv scoring genom att klicka på den. 

Spara scoring 

Spara aktiv scoring genom att klicka på länken Save Scoring. Du uppmanas att ange ett namn på den 

scoring som ska sparas. Sparad scoring läggs till i listan med scoringar. 

Rensa scoring 

Om en scoring är aktiv rensas den med alternativet Clear Scoring. Om aktiv scoring har lokala 

ändringar tillfrågas du om du vill spara dina lokala ändringar. 
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Återställa scoring 

Om en scoring har lokala ändringar som inte har sparats, kan ändringarna återställas. Det innebär att 

aktuell scoring återgår till samma egenskaper som då den laddades. 

Radera vald scoring 

Radera en sparad scoring genom att markera den i listan med scoringar och klicka på länken Delete 

Selected Scoring. En dialogruta visas där du uppmanas att bekräfta att aktuell scoring ska raderas. 

Kortkommandon för scoring 

Kortkommandon används för att scora händelser på ett snabbt sätt. En lista med befintliga 

kortkommandon för scoring finns under Edit → Configuration → Scoring Shortcut Keys…, där du 

också kan ändra kortkommandona. 

Som regel ska kortkommandon för händelser bara omfatta en tangent, men en kombination av ctrl, 

skift eller alt plus en tangent fungerar också bra. 

Skapa rapporter 

Rapporter används för att sammanfatta analyserade data. Skapa en rapport genom att klicka på 

menyn Reports och välja en rapport i listan med tillgängliga rapporter. 

Rapporter visas på en ny sida som läggs till på arbetsytan.  

 

 Rapportresultat är konstanta och uppdateras inte när inspelningsanalysen 

ändras. 

 Om ändringar görs i analysen kan en annan rapport skapas. 

 

När du har skapat en rapport är det enkelt att ändra den med hjälp av knappen Edit som finns i 

verktygsfältet när du visar rapporter. 

 

Med knappen Edit öppnar du redigeringsläget där du kan redigera rapporten på samma sätt som i 

Microsoft Word®. Alla ändringar som du gör visas omedelbart. Du kan också lägga till nya index och till 

och med delar av fördefinierade rapporter när du tolkar en studie. Tryck på knappen Edit en gång till 

om du vill avsluta redigeringsläget. 

Du kan lägga till så många rapporter du vill på arbetsytan. 
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Anpassa rapporter 

Rapporter i Noxturnal kan anpassas. Om du vill skapa en anpassad rapport väljer du menyn Reports 

och sedan Manage Reports…. 

Fönstret Manage Reports öppnas där du kan välja den rapport som du vill basera din nya rapport på. 

Du kan också skapa en ny tom rapport. 

 

 

När du väljer länken New visas en dialogruta där du ombeds att ange ett namn på rapporten, en 

kategori och en mall att utgå ifrån. Nästa steg är att skapa rapporten genom att lägga till innehåll och 

struktur efter behov. Nu skapas en ny rapportmall i din 

samling som du kan använda senare. 

 

I rapportredigeraren kan du lägga till nya fält i rapporten från 

den omfattande samlingen med fördefinierade fält i 

Noxturnal. Du kan enkelt söka efter fält som du vill använda i 

rapporten. De flesta fält omfattar för sökbarhetens skull en 

kort beskrivning av innehållet. 

I det här fönstret kan du också skapa nya fält som är 

intressanta med hjälp av fältredigeraren. Fältredigeraren är 

en kraftfull funktion som du kan använda för att kombinera 

och beräkna olika fält för flexibla analysresultat, med naturligt 

språk. 
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Exportera rapporter 

För att exportera en rapport väljer du motsvarande rapportflik i arbetsytfönstret. Klicka på File → 

Export Sheet... Ett nytt fönster öppnas där du anger filformat och filnamn. Klicka på Save när du är 

klar så sparas rapporten till disk i det angivna filformatet. Följande format kan väljas: 

 PDF (standard) 

 Html 

 RTF 

Standardrapporter 

I Noxturnal ingår flera standardrapporter som installeras med programmet. De kan enkelt ändras så 

att de passar olika användarbehov. 

Skriva ut rapporter 

Efter att en rapport har skapats kan du skriva ut rapporten. Välj först den rapport du vill skriva ut på 

arbetsytans flikar. Skriv ut rapporten genom att klicka på knappen Print i rapportverktygsfältet. Ett 

fönster öppnas där du kan ändra utskriftsalternativen. Klicka på knappen Print när du har justerat 

inställningarna. 
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Inspelningsbiblioteket 

I inspelningsbiblioteket visas och hanteras alla inspelningar som har laddats ned från 
registreringsenheterna. När inspelningar öppnas eller laddas ned i Noxturnal läggs de automatiskt till i 
inspelningsbiblioteket. 
 
Om du vill öppna en inspelning väljer du den i inspelningsbibliotekets lista och dubbelklickar på 
listposten eller klickar på knappen Open recording i fönstret med inspelningsinformation. 

Arkivera inspelningar 

Inspelningar i inspelningsbiblioteket kan arkiveras på en annan plats eller för permanent lagring. 
Arkivera en inspelning genom att markera en eller flera inspelningar i biblioteket och klicka på 
knappen Archive Recording… i fönstret med inspelningsinformation. En dialogruta visas med stegvisa 
instruktioner för arkiveringsprocessen. 
 

Inspelningsmallar 

Inspelningsmallar skapas för alla standardinspelningar som du kan komma att utföra med Nox-

registreringsenheter. De är enkla att konfigurera under enhetens installationsprocess och de sparar 

tid. 

Redigera och skapa inspelningsmallar genom att gå till Devices → Recording Templates. I det fönstret 

visas alla tillgängliga inspelningsmallar för Nox-registreringsenheter. 

 

Om du vill lägga till en egen mall väljer du New eller New Based On för någon av de inspelningsmallar 

som visas där. Systemets standardmallar kan eventuellt inte redigeras men du kan enkelt skapa dina 

egna mallar baserat på standardmallarna. Dessa kan du redigera så mycket du vill. 
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Lägg till en ny inspelningsmall genom att välja knappen New. Nu måste du välja för vilken 

registreringsenhet mallen ska skapas och vilken av de befintliga inspelningsmallarna som din nya mall 

ska baseras på. 

 

I den här guiden konfigurerar du dina inspelningsmallar. Du måste ge inspelningsmallen ett namn. Du 

måste också välja typ av studie och helst ange en kort beskrivning. Fortsätt till nästa fönster genom 

att trycka på Next. 

I nästa fönster kan du välja de kanaler som ska ingå i din inspelning. Du kan till och med ändra typ av 

kanal för Custom Channels till vänster. Det gör du genom att trycka på det kanalnamn som du vill 

ändra. Nu visas en mängd alternativ. 
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Fortsätt till nästa fönster genom att trycka på Next. 

 

I fönstret Respiratory channels kan du ändra hur registreringsenheten registrerar flöde. Du kanske till 

exempel vill ansluta tryckingången till en PAP-enhet istället för att registrera nasalt flöde. Det är också 

här du anger om din inspelningsmall ska använda True Audio istället för envelope-ljud. 
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Slutligen väljer du batterityp och trycker på Finish. Nu har du skapat en inspelningsmall som du kan 

använda när du konfigurerar en Nox-registreringsenhet. 

 

 Guiden för inspelningsmallar varierar beroende på vilken registreringsenhet 

som avses. 
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Felsökning 

Det här avsnittet innehåller information om felsökning i programmet. Kontakta teknisk support om 

systemet inte fungerar som det ska och problemet kvarstår efter att anvisningarna nedan följts. 

Problem med att installera Noxturnal  

 När programmet Noxturnal installeras måste du vara inloggad i datorn som administratör. 

Detta krävs eftersom vissa filer kopieras till delade platser. Kontakta datoradministratören 

om du inte har administratörsbehörighet. 

 Om installationen av Noxturnal misslyckas ska du avinstallera den tidigare versionen och 

installera om programmet. 

Problem med att kommunicera med en registreringsenhet  

Om du har problem med att ansluta till och kommunicera med en registreringsenhet ska du 

kontrollera följande: 

 USB-kabelanslutningar: Kontrollera att USB-kabeln är ordentligt ansluten till Nox-enheten 

och till USB-porten på datorn. 

 USB-porten har inte tillräcklig effekt: Försök ansluta USB-kabeln till en annan port på datorn, 

helst en USB-hubb med extern strömförsörjning. 

 Fel på USB-kabeln: Försök ansluta med en annan USB-kabel. 

 Problem med USB-enheten på datorn: Enheten fungerar som en standard-USB-

masslagringsenhet när den är ansluten till datorn. Kontrollera om andra USB-enheter 

fungerar på datorn. Om inte, så ligger problemet hos operativsystemet och du bör läsa 

användarhandboken till operativsystemet för information om felsökning av USB-enheter. 

Om ovanstående åtgärder inte löser problemet kan enhetens filsystem ha förstörts. Det kan 

exempelvis hända om Eject Device inte har använts för att mata ut enheten. Följande symptom kan 

tyda på det: 

 Noxturnal känner inte igen enheten. 

 Operativsystemfel inträffar när enheten ansluts. 

 Problem uppstår när enheten konfigureras. 

 Problem uppstår när inspelningar laddas ned från enheten. 

Om det finns inspelningar på enheten bör du försöka åtgärda problemet på följande sätt: 

1. Anslut enheten till datorn. 

2. När en enhet ansluts till datorn visas den som en standardlagringsenhet i operativsystemet. 

Leta reda på enheten i operativsystemet och kör operativsystemets felkontroll. I hjälpen till 

operativsystemet finns information om hur åtgärden utförs (sök efter ”chkdsk” i hjälpen till 

Windows). 
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Om ovanstående metod inte fungerar kan du försöka återställa enheten till fabriksinställningar enligt 

följande: 

1. Anslut enheten till en dator. 

2. Klicka på knappen Framåt på registreringsenheten. Följande ska visas på enhetens display: 

 

3. Formatera och återställ enheten till fabriksinställningar genom att hålla ned mittknappen på 

enheten i några sekunder och följa anvisningarna som visas på enhetens display. 

 

►När du återställer enheten till fabriksinställningar raderas alla inspelningar som finns 

på enheten. Om dessa inspelningar ännu inte har laddats ned går de förlorade. 

Problem med att visa inspelningsresultat  

 En rapport kan visas utan innehåll om ingen skrivare har ställts in i datorn. Åtgärda 

problemet genom att installera en skrivardrivrutin och välja den som standardskrivare. I 

rapporten används den sidstorlek som gäller för standardskrivaren vid framställning av 

rapporter. 

 Om inspelningsparametrarna alltid visas som noll (AHI, snarkningsandel, ODI osv.) indikerar 

det vanligtvis att den automatiska analysen inte har slutförts. Försök åtgärda problemet på 

följande sätt: 

o Välj Analysis → Manage Protocols och ta bort Respiratory RIP Flow och Respiratory 

Cannula Flow. Starta om programmet. Analysprotokollen återställs nu till 

installationsstandard. Kör ett av protokollen för att fastställa om problemet har 

åtgärdats. 

o Välj Edit → Configuration → Signal Types & Groups… Ta bort alla signalgrupper i 

den dialogruta som visas. Stäng Noxturnal och öppna det igen. Alla signalgrupper 

återställs nu till installationsstandard. Kör ett av standardprotokollen för att 

fastställa om problemet har åtgärdats. 


